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QE for Capacitive Touch V4.3.0 

Release Note 

Thank you very much for using the QE for Capacitive Touch V4.3.0. 

This release note covers product installation, restrictions, and so on. Please read this document before using 
the product. 
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1. About QE for Capacitive Touch 

1.1 Summary 

QE for Capacitive Touch is an assistance tool for applications and operates under the e2 studio integrated 
development environment. In the development of an embedded system based on an RX family, RA family, 
RL78 family or Renesas Synergy MCU that incorporates the capacitive touch sensing unit (hereafter the 
CTSU), this product facilitates the easy initialization of touch interfaces and tuning of their sensitivity, thus 
reducing development times. 

To use this product, you will first need to add a project for the RX family, RA family, RL78 family or Renesas 
Synergy MCU and the capacitive touch sensor-related CTSU driver and Touch middleware. 

 

1.2 Functions 

The three functions below make it easy to develop applications that involve capacitive touch sensors. 

1. Creating touch interface configurations 

2. Tuning 

3. Monitoring and parameter adjustment 

 

Also, it is easy to develop gesture applications using e-AI. QE's three functions, "recording function", "AI 
generation function", and "monitoring and tuning function", support AI application development, which is a 
difficult process with many steps. Anyone can develop AI applications without the need for specialized AI 
skills 

 

1.3 New Functions 

1.3.1 Diagnostic Function Improvements (CTSU2) 

Improved diagnostic functions for CTSU2 devices. For details on the diagnostic functions, please refer to the 
application note below. 

➢ RX Family QE CTSU module Firmware Integration Technology 

➢ RL78 Family CTSU Module Software Integration System 

* To use the diagnostic function, a touch I/F other than the "Shield Pin," "Temperature Compensation Pin," 
"Current Sensor," or "MEC" is required. 

 

1.3.2 Changes to Advanced Mode Settings 

The following changes were made to Advanced Mode settings. 

 

1.3.2.1 Transmit Power Setting (CTSU2) 

1. The name of the transmit power supply setting item “VCC” was changed to the correct name for each 
device. 
 

Device Before After 

RX 

VCC 

VCC 

RA / Synergy VCC/AVCC 

RL78 VDD/EVDD 

 

2. Default settings when selecting “Auto” were reviewed. 
 

Touch interface configuration Before After 

https://www.renesas.com/document/apn/rx-family-qe-ctsu-module-using-firmware-integration-technology
https://www.renesas.com/document/apn/rl78-family-ctsu-module-software-integration-system?srsltid=AfmBOorIUaR3jERJt0xWD41fRNx2J-Tq4eSSm6DO2Zs9MkBgFh9zuEME
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Self-capacitance  
(no shield pin) 

VCC Internal logic power supply 

Self-capacitance  
(with shield pin) 

Internal logic power supply Internal logic power supply 

Others VCC (private) VCC (private) 

 Note: Only the “Self-capacitance (no shield pin)” setting was changed. 
 

1.3.2.2 Base Clock Frequency / Sensor Drive Pulse Frequency Setting (Slider/Wheel) 

The configuration has been improved so that when the base clock frequency or sensor-drive pulse frequency 
of any TS pin used for a slider or wheel is modified, the same settings are automatically applied to all other 
TS pins that constitute the slider or wheel. 

 

1.3.2.3 Measurement Time Setting 

Improved so that an error is generated if a measurement time that may cause measurement value overflow 
is set. 

 

1.3.3 Bug Fixes 

The following issues were fixed: 

1. When the touch interface configuration is changed in the CapTouch Workflow (QE) view after tuning, 
the capacitance values displayed in the CapTouch Multi Status Chart (QE) view were incorrect. 

2. The frequency value displayed in the Advanced Mode base clock setting for CTSU1 devices was 
incorrect. 

3. The notes for measurement result of CTSU driver and the tuning feature of this product, as described in 
Tool News (R20TS1229EJ0100), have been resolved. 

 

1.3.4 Improvements to Usage Considerations 

The following usage considerations described in the QE for Capacitive Touch V4.2.0 release note were 
improved: 

1. Removed SNRSUM value from standard deviation measurement results because it is for reference 
only. (V4.2.0 Release Notes Section 3.1.4) 

2. Improved so that the actual sensor drive pulse frequency is displayed in the sensor drive pulse 
frequency field in the CapTouch Board Monitor (QE) view. (V4.2.0 Release Notes Section 3.1.4) 

3. Improved sample code for using the diagnostic function together with the DTC function. (V4.2.0 Release 
Notes Section 3.1.10) 

4. Improved an issue where the CapTouch Workflow (QE) view displayed incorrectly. (V4.2.0 Release 
Notes Section 3.1.15) 

5. Improved an issue where e2 studio might not start when an RA device project is selected in the 
CapTouch Workflow (QE) view. (V4.2.0 Release Notes Section 3.1.16) 

 

 

1.4 Supported Environments 

1.4.1 For Plugin Version 

Windows 11 

Renesas e2 studio 2025-12 

* If you are using a version of the e2 studio 2025-07 or earlier, please update it to 2025-12. 
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1.4.2 For Standalone Version 

Windows 11 

 

1.5 Confirmed Debugging Tools 

• RX Family 

⎯ E2 emulator 

⎯ E2 emulator Lite 

⎯ J-Link 

• RA Family 

⎯ E2 emulator 

⎯ E2 emulator Lite 

⎯ J-Link 

• RL78 Family 

⎯ E2 emulator 

⎯ E2 emulator Lite 

• Renesas Synergy 

⎯ J-Link 

 

1.6 Supported Microcontrollers 

• RX Family (only MCUs that incorporate the CTSU) 

⎯ RX100 Series: RX113, RX130, RX140 

⎯ RX200 Series: RX230, RX231, RX23W, RX260, RX261 

⎯ RX600 Series: RX671 

• RA Family (only MCUs that incorporate the CTSU) 

⎯ RA0 Series: RA0L1 

⎯ RA2 Series: RA2A1, RA2E1, RA2L1 

⎯ RA4 Series: RA4L1, RA4M1, RA4M2, RA4M3, RA4W1 

⎯ RA6 Series: RA6M1, RA6M2, RA6M3, RA6M4, RA6M5  

• RL78 Family (only MCUs that incorporate the CTSU) 

⎯ RL78/F22 

⎯ RL78/F25 

⎯ RL78/G16 

⎯ RL78/G22 

⎯ RL78/G23 

⎯ RL78/L23 

• Renesas Synergy (only MCUs that incorporate the CTSU) 

⎯ S1 Series: S124, S128, S1JA 

⎯ S3 Series: S3A1, S3A3, S3A6, S3A7 

⎯ S5 Series: S5D3, S5D5, S5D9 

⎯ S7 Series: S7G2 
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1.7 Supported Software 

• Driver and middleware for capacitive touch sensor  

⎯ RX Firmware Integration Technology (FIT) 

➢ CTSU driver: r_ctsu_qe V3.30 

➢ Touch middleware: rm_touch_qe V3.30 

⎯ RA Flexible Software Package (FSP) 

➢ CTSU driver: r_ctsu V6.4.0 

➢ Touch middleware: rm_touch V6.4.0 

Note: If you use diagnostic function, please use the next version. 

⎯ RL78 Software Integration System (SIS) 

➢ CTSU driver: r_ctsu V2.30 

➢ Touch middleware: rm_touch V2.30 

⎯ Renesas Synergy Software Package (SSP) 

➢ CTSU driver: r_ctsuv2 V2.6.0 

➢ Touch framework: sf_touch_ctsuv2 V2.6.0 
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2. Installation and Uninstallation 

2.1 Installing This Product 

Use either of the following procedure to install this product. 

 

2.1.1 Install from the "Renesas Software Installer" menu of e2 studio 

1. Start e2 studio. 

2. Select the “Renesas Views” - “Renesas Software Installer” menu of e2 studio to open the “Renesas 

Software Installer” dialog box. 

3. Select the “Renesas QE” and click the “Next>” button 

4. Select the “QE for Capacitive Touch (v4.3.0)” check box, and click the “Finish” button. 

5. Check that the “Renesas QE for Capacitive Touch” check box is selected in the “Install” dialog box, and 

click the “Next>” button. 

6. Check that the “Renesas QE for Capacitive Touch” check box is selected as the target of installation, and 

click the “Next>” button. 

7. After confirming the license agreements, if you agree to the license, select the “I accept the terms of the 

license agreements” radio button, and click the “Finish” button. 

8. If the dialog of the trust certificate is displayed, check that certificate, and click the “OK” button to continue 

installation. 

9. When prompted to restart e2 studio, restart it. 

10. Start this product from the “Renesas Views” - “Renesas QE” menu of e2 studio. For details about how to 

use this product, see the “Help” menu of e2 studio. 
 
 

2.1.2 Install using QE (zip file) downloaded from the Renesas website 

A downloaded zip file has both a plugin version and a standalone version. 

 

2.1.2.1 Install Plugin Version 

1. Extract the downloaded zip file. 

2. Start the e2 studio. 

3. Click on “Help”, and then click on the “Install New Software...” menu item to open the “Install” dialog box. 

4. Click on the “Add...” button to open the “Add Repository” dialog box. 

5. Click on the “Archive...” button, select the installation file (zip file under the QE-CapTouch folder) in the 

opened file selection dialog box, and then click on the “Open” button. 

6. Click on the “OK” button in the “Add Repository” dialog box. 

7. Expand the “Renesas QE” item shown in the “Install” dialog box, select the “Renesas QE for Capacitive 

Touch” check box, and then click on the “Next>” button. 

* If you check off the “Contact all update sites during install to find required software” checkbox, you can 

shorten the installation time. 

8. Confirm that the installation target is “Renesas QE for Capacitive Touch”, and then click on the “Next>” 

button. 

9. After checking the license, select the “I accept the terms of the license agreements” radio button if you 

agree it, and then click on the “Finish” button. 

10. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then 

click on the “OK” button to continue installation. 

11. Restart the e2 studio by following the instructions on the screen. 

12. Start this product from the “Renesas Views” - “Renesas QE” menu of the e2 studio. 
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2.1.2.2 Install Standalone Version 

1. Extract the downloaded zip file. 

2. Move the QE-CapTouch folder to any folder. 

* Avoid moving to the Windows folder or Program Files folder or folders whose name contain spaces. 

3. Start this product from the “QE-CapTouch\eclipse\qe-captouch.exe” file. 
 
 

2.2 Updating This Product (for Plugin Version) 

If you have already installed this product, you can update it in the same way as the procedure for installation 
2.1.2.1. 

 

2.3 Uninstalling This Product 

Follow the procedure below to uninstall this product. 

 

2.3.1 Uninstall Plugin Version 

1. Start the e2 studio. 

2. Select “Help -> About e2 studio” to open the “About e2 studio” dialog box. 

3. Click the “Installation Details” button to open the “e2 studio Installation Details” dialog box. 

4. Select “Renesas QE for Capacitive Touch” displayed on the “Installed Software” tabbed page and click on 

the “Uninstall...” button to open the “Uninstall” dialog box. 

5. Check the displayed information and click on the “Finish” button. 

6. When you are prompted to restart the e2 studio, restart it. 
 
 

2.3.2 Uninstall Standalone Version 

1. Delete the QE-CapTouch folder. 
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3. Notes / Restrictions 

3.1 Usage Considerations 

Please pay attention to the following items. 

 

3.1.1 Notes on the clock supplied to the CTSU 

1. Ensure that the clock supplied to CTSU (PCLKB or fCLK) is set to the following frequencies or 

higher. Lower frequencies are not supported. 

・ CTSU:  8MHz 

・ CTSU2: 1MHz 

 

3.1.2 Notes on RA4L1 Usage 

 

1. When using RA4L1 at an ambient temperature over 85℃, the sensor drive pulse frequency set 

by the tuning touch sensors of the QE for Capacitive Touch may be too high, resulting in 

inaccurate measurements. 

If the measurement values are small or unstable, this may be the case. Consider lowering the 

sensor drive pulse frequency to obtain stable measurement values. 

 

 

3.1.3 Notes on Tuning 

 

1. If there are multiple debugging configurations in the target project, automatic tuning may fail.  

Please check whether it is possible to debug the target board using the IDE’s function. If there 

are multiple debugging configurations in the target project, the configurations used for debugging 

in the last time is chosen to automatic tuning. If the debug configuration used in last time is 

different from the project for automatic tuning, QE cannot start debugging. Before starting 

automatic tuning, please debug target project once. 

2. When the “Automatic Tuning Processing” dialog box is waiting for key input, pressing the 

“Cancel” / “Help” button is not possible. 

3. When using a board without a sub-clock (e.g. Capacitive Touch Evaluation System for RA2L1), 

the project is not executed up to the main() function and the tuning function cannot be used. 

Change the FSP's “BSP” property – “Subclock Populated” setting to "Not Populated". 

4. When using RL78/G22, the tuning function cannot be used for touch I/F configuration that include 

current sensor. 

5. Do not use the Watchdog Timer (WDT) when using the tuning function. Since the WDT counter 

is not cleared during tuning, the counter may overflow, causing a reset. This will result in tuning 

failure. 

6. When using serial communication for tuning, tuning cannot start if the timer interrupt in the user 

program conflicts with the UART receive interrupt used in the tuning process. Please either 

increase the priority of the UART receive interrupt or avoid using the timer. 

7. The following touch I/F are not supported for tuning via serial communication: 

・ 3D Gesture 

・ Touch Pad 

・ Current Sensor 

8. When performing tuning using serial communication with a touch I/F configuration in which touch 

judgment (SMS) is enabled, follow the procedure below: 

・ In the Create Configuration of Touch Interfaces dialog, disable touch judgment (SMS). 

・ Output files required for a tuning process. 

・ In the Create Configuration of Touch Interfaces dialog, enable touch judgment (SMS). 

・ Perform tuning. 
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3.1.4 Notes on Monitoring 

 

1. When monitoring using serial communication on the RX family, set the TX buffer size of the SCI 

FIT module (r_sci_rx) to the same size as the QE monitoring buffer (g_touch_monitor_buf). 

The QE monitoring buffer size is the value defined by the TOUCH_MONITOR_BUFFER_SIZE 

macro. 

2. For RL78 Family, the emulator has a low data rate, and as the number of buttons increases, 
monitoring using the emulator becomes impossible. In such cases, please use serial 
communication for monitoring. 

3. If you need to perform memory access while monitoring using serial communication on 

RL78/G16, the following settings are required. 

・ Set "Pseudo-RRM/DMM function setting" to "Used" in Smart Configurator. 

・ In the C/C++ build settings of the project, set the address in “Tool Settings” – “Linker” – 

“Device” – “Reserve working memory for RRM/DMM function (-rrm)” so that the first 4 bytes 

of RAM are not used. 

・ In the debug configuration, set "Debugger" - "Debug Tool Settings" - "Allow to access by 

stopping execution while running" to "Yes". 

4. In the CapTouch Parameters (QE) view, the contents may not be displayed after selecting a 

Touch I/F. 

Please close the CapTouch Parameters (QE) view once and then reopen it. 

5. In the CapTouch Parameters (QE) view, when writing multiple parameters to the target board at 

once, some parameters may not be written successfully. 

Please try writing to the target board again. 

 

3.1.5 Notes on Serial Connection 

 

1. Before connecting to the Fast Prototyping Board (FPB) using a serial port, please see the 

documentation that came with the FPB and the user's manual of the FPB. 

 

3.1.6 Notes on creating touch interface configuration 

 

1. The RAM size of the MCU may be exceeded depending on the number of touch interfaces 

(buttons, sliders, wheels, etc.). Please create the touch interface configuration considering the 

amount of memory used by the touch function and the user program. Pay particular attention to 

MCU, which has a maximum RAM size of 2 KB.  

2. When importing a touch interface configuration across different MCU, please review the touch 

interface configuration again after import. 

 

3.1.7 Notes on Standalone Version 

 

1. It may be slow to enable / disable the internal toolbar buttons of each view. Please move the 

focus to another view once. 

2. The 3D gesture recognition is not available in the standalone version. Please use the plugin 

version. 

 

3.1.8 Notes on TrustZone 

 

1. The tuning processing using an emulator cannot be performed on the non-secure side. Please 

perform one of the following: 

 Perform tuning using serial communication. 

 Perform tuning using an emulator on the secure side and use results on the non-secure 

side. 
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2. Monitoring of hardware touch judgment is not supported. 

 

3.1.9 Notes on Hardware Touch Judgment Function 

 

1. If you are using only the hardware touch judgment function and not using software judgement, 
please do not add the touch middleware in the smart configurator. For usage examples, please 
refer to the sample code provided by QE for Capacitive Touch. 

2. When using the hardware touch judgment function, tuning and monitoring using serial 

communication are not available. 

3. Even when you start monitoring, there may be cases where the monitoring data is not updated. 

After pausing and resuming the program, please start monitoring again. 

4. When using hardware touch judgment with the RA family, set the [Number of Transfer 

Descriptors] in the FSP DTC module (g_transfer0 / g_transfer1) to the following values. 

 g_transfer0 g_transfer1 

Hardware touch judgment (VMM) 8 5 

Hardware touch judgment (JMM) 6 5 

Hardware touch judgment (VMM + JMM) 8 5 

 

5. When the touch threshold or hysteresis value is changed in the CapTouch Parameters view and 

then written to the target board, the value may not change to the specified value or may change 

to a value different from the specified value. 

In the case of touch threshold, change the hysteresis value to a sufficiently small value before 

writing. 

In case of hysteresis, please change the value of touch threshold to a sufficiently large value 

before writing. 

6. When using hardware touch judgment function with QE for Capacitive Touch V4.0.0, please use 

RX FIT V3.00 or later and RL78 SIS V2.0.0 or later. 

7. For RX260 and RX261, the " VMM" can be selected for hardware touch judgment, but it is not 
available in RX FIT V3.00. Please use RX FIT V3.10 or later. 

 

3.1.10 Notes on CapTouch Workflow (QE) View 

 

1. If you press the "Maximize"/"Restore" button in the e2 studio  window while playing a tutorial 

video with the video window maximized, you will not be able to maximize the video window 

again. 

Close and re-open the CapTouch Workflow (QE) view. 

2. The workflow cannot be opened if WebView2 Runtime is not installed on your PC. 

Download and install WebView2 (x64 version) from the Microsoft web page.（FAQ:3000670） 

3. If you close e2 studio while the display screen is being created when opening the CapTouch 

Workflow (QE) view, the background process may not terminate and e2 studio may not launch.  

In that case, end the e2 studio.exe task in the background processes via Task Manager.  

 

3.1.11 Notes on View Operation 

 

1. When floating (detaching from e2 studio) each view in QE for Capacitive Touch, it may not 

function correctly. 

Please use each view without floating. 

2. When the following operations are performed, multiple instances of the CapTouch Status Chart 

view may be displayed. In this case, please reset the CapTouch Monitor (QE) perspective. 

① Display the CapTouch Status Chart (QE) view in the editor area without the CapTouch 

Monitor (QE) perspective being added. 

② Add the CapTouch Monitor (QE) perspective afterward. 

https://en-support.renesas.com/knowledgeBase/20814216
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3.1.12 Notes on Using Renesas Synergy Projects 

 

1. When using e2 studio 2023-01 or later, an error indicating that an invalid touch sensor is 

assigned will be displayed during the creation of a touch interface configuration, preventing the 

configuration from being created. 

Please use one of the following methods to create the configuration: 

 Create the touch interface configuration on QE before adding the Touch SSP module on 
Smart Configurator. 

 Use e2 studio 2022-10. 

 

3.1.13 Notes on Installation 

 

1. When installing QE for Capacitive Touch V3.5.0 or later plugin version, the “Trust Artifacts” dialog 

box displays the QE for Capacitive Touch plugin as unsigned. 

Check “Unsigned” and click the “Trust Selected” button to continue the installation. 

 

3.1.14 Notes on Help Window Operations 

 

1. While a modal dialog is displayed, the help window cannot be operated.  

Please operate the Help window using one of the following methods: 

 Close the modal dialog once, and then operate the Help window. 

 Configure the Help window to open in an external browser using the following settings: 

Open the [Window] → [Preferences…] menu to display the Preferences dialog. Select 

[Help], and set [Open help contents] to “In an external browser.” 

 

3.1.15 Notes on Display Scaling Settings 

 

1. Depending on the display scaling setting, the GUI of this product may not be displayed correctly.  

In that case, set Windows display scaling to “100%.” 

2. If multiple displays are used and their scaling settings differ, moving e2 studio to a different 

display may prevent correct operation (e.g., clicking a touch interface does not select it).  

In that case, use e2 studio on the display where it was launched, or set the scaling to the same 

value for all displays. 

 

3.2 Functional Restrictions 

There are restrictions in QE for Capacitive Touch V4.3.0. 

 

3.2.1 Restrictions on Standalone Version 

 

1. Help files are not existed. 

 

3.2.2 Restrictions on RL78/G16 Monitoring Function 

 

1. When using RL78/G16, monitoring using an emulator is not available. Please use serial 

communication for monitoring. 

When debugging by memory access during monitoring, refer to 3.1.4 Notes on Monitoring. 

 

3.2.3 Restrictions on Tuning 
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1. When performing tuning using an emulator on the RL78 family, please ensure that the debug stack 
area does not overlap with the tuning RAM program area. If these areas overlap, tuning will not be 
performed correctly. 
For more details about the debug stack area, refer to the " On-chip Debugging" section in the RL78 
microcontroller's User Manual: Hardware. 
The tuning RAM program area is allocated as follows: (QE for Capacitive Touch writes and executes 
the tuning program in the RAM area). 

・ RL78/F22: 0xFD530 – 0xFF130 

・ RL78/F25: 0xFD530 – 0xFF130 

・ RL78/G22: 0xFEF00 – 0xFFE00 

・ RL78/G23: 0xFCF00 – 0xFEB00 

・ RL78/L23: 0xFCF00 – 0xFEC00 
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4. Related Videos 

Many videos about this product are published in the Renesas website. 

 

• Getting Started with QE for Capacitive Touch for RX (old version) 

⎯ https://www.renesas.com/video/getting-started-qe-capacitive-touch 

• Getting Started with QE for Capacitive Touch for RL78 

⎯ https://www.renesas.com/video/getting-started-qe-capacitive-touch-rl78 

• Getting Started with QE for Capacitive Touch for RA 

⎯ https://www.renesas.com/us/en/video/getting-started-qe-capacitive-touch-ra 

• QE for Capacitive Touch [Tutorial -Settings-] for RX (old version) 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-settings 

• QE for Capacitive Touch [Tutorial -Tuning-] for RX (old version) 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-tuning 

• QE for Capacitive Touch [Tutorial -Monitoring-] for RX (old version) 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-monitoring 

• QE for Capacitive Touch Tutorial: Settings for RL78 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-settings-rl78 

• QE for Capacitive Touch Tutorial: Tuning for RL78 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-tuning-rl78 

• QE for Capacitive Touch Tutorial: Serial Monitoring for RL78 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-serial-monitoring-rl78 

• QE for Capacitive Touch Tutorial: Step 1 Configuration for RA 

⎯ https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-1-configuration-ra 

• QE for Capacitive Touch Tutorial: Step 2 Tuning for RA 

⎯ https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-2-tuning-ra 

• QE for Capacitive Touch Tutorial: Step 3 Monitoring for RA 

⎯ https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-3-monitoring-ra 

• QE for Capacitive Touch Feature - Measuring Standard Deviation 

⎯ https://www.renesas.com/video/qe-capacitive-touch-feature-measuring-standard-deviation 

• QE for Capacitive Touch Feature - Check Monitoring Values Using The Monitoring Log Feature 

⎯ https://www.renesas.com/video/qe-capacitive-touch-feature-check-monitoring-values-using-

monitoring-log-feature 

• QE for Capacitive Touch Feature - Two Types of Touch Judgment Modes with CTSU2 and QE 

⎯ https://www.renesas.com/video/qe-capacitive-touch-feature-two-types-touch-judgment-modes-ctsu2-

and-qe 

• QE for Capacitive Touch Feature - Two Types of Touch Judgment with CTSU2S and QE 

⎯ https://www.renesas.com/video/qe-capacitive-touch-feature-two-types-touch-judgment-ctsu2s-and-qe 

• QE for Capacitive Touch Feature – A New Workflow Diagram in QE V3.2.0. 

⎯ https://www.renesas.com/us/en/video/qe-capacitive-touch-feature-new-workflow-diagram-qe-v320 

• QE for Capacitive Touch Tips - Warning Message Appeared During Tuning 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tips-warning-message-appeared-during-tuning 

• How to tune via serial communication using the standalone app of QE. 

⎯ https://www.renesas.com/video/how-tune-serial-communication-using-standalone-app-qe 

• How to migrate the touch modules from version 1.1 to version 2.0 using the compatible APIs with QE tool. 

⎯ https://www.renesas.com/video/how-migrate-touch-modules-version-11-version-20-using-compatible-

apis-qe-tool 

• QE for Capacitive Touch Tutorial: How to Tune via Serial Communication Using the Plug-in 

⎯ https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-how-tune-serial-communication-

using-plug 

• 3D Gesture AI Solution - QE for Capacitive Touch Makes It Easy To Develop a Contactless User 

Interface 

⎯ https://www.renesas.com/video/3d-gesture-ai-solution-qe-capacitive-touch-makes-it-easy-develop-

contactless-user-interface 

https://www.renesas.com/video/getting-started-qe-capacitive-touch
https://www.renesas.com/video/getting-started-qe-capacitive-touch-rl78
https://www.renesas.com/us/en/video/getting-started-qe-capacitive-touch-ra
https://www.renesas.com/video/qe-capacitive-touch-tutorial-settings
https://www.renesas.com/video/qe-capacitive-touch-tutorial-tuning
https://www.renesas.com/video/qe-capacitive-touch-tutorial-monitoring
https://www.renesas.com/video/qe-capacitive-touch-tutorial-settings-rl78
https://www.renesas.com/video/qe-capacitive-touch-tutorial-tuning-rl78
https://www.renesas.com/video/qe-capacitive-touch-tutorial-serial-monitoring-rl78
https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-1-configuration-ra
https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-2-tuning-ra
https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-step-3-monitoring-ra
https://www.renesas.com/video/qe-capacitive-touch-feature-measuring-standard-deviation
https://www.renesas.com/video/qe-capacitive-touch-feature-check-monitoring-values-using-monitoring-log-feature
https://www.renesas.com/video/qe-capacitive-touch-feature-check-monitoring-values-using-monitoring-log-feature
https://www.renesas.com/video/qe-capacitive-touch-feature-two-types-touch-judgment-modes-ctsu2-and-qe
https://www.renesas.com/video/qe-capacitive-touch-feature-two-types-touch-judgment-modes-ctsu2-and-qe
https://www.renesas.com/video/qe-capacitive-touch-feature-two-types-touch-judgment-ctsu2s-and-qe
https://www.renesas.com/us/en/video/qe-capacitive-touch-feature-new-workflow-diagram-qe-v320
https://www.renesas.com/video/qe-capacitive-touch-tips-warning-message-appeared-during-tuning
https://www.renesas.com/video/how-tune-serial-communication-using-standalone-app-qe
https://www.renesas.com/video/how-migrate-touch-modules-version-11-version-20-using-compatible-apis-qe-tool
https://www.renesas.com/video/how-migrate-touch-modules-version-11-version-20-using-compatible-apis-qe-tool
https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-how-tune-serial-communication-using-plug
https://www.renesas.com/us/en/video/qe-capacitive-touch-tutorial-how-tune-serial-communication-using-plug
https://www.renesas.com/video/3d-gesture-ai-solution-qe-capacitive-touch-makes-it-easy-develop-contactless-user-interface
https://www.renesas.com/video/3d-gesture-ai-solution-qe-capacitive-touch-makes-it-easy-develop-contactless-user-interface
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• QE for Capacitive Touch Tutorial: How to create the gesture data 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-how-create-gesture-data 

• QE for Capacitive Touch Tutorial: How to monitor gesture AI 

⎯ https://www.renesas.com/video/qe-capacitive-touch-tutorial-how-monitor-gesture-ai 

https://www.renesas.com/video/qe-capacitive-touch-tutorial-how-create-gesture-data
https://www.renesas.com/video/qe-capacitive-touch-tutorial-how-monitor-gesture-ai
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5. BSD-3-Clause License 

Starting from V4.2.0, the license for source code output by this product has been changed from the Renesas 
Default Disclaimer to the BSD-3-Clause license. 

BSD 3-Clause License 

----------------------------------------------------------------------------------------------------------------------------- ---------------- 

Copyright 2025, Renesas Electronics Corporation and/or its affiliates 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 
that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation  

and/or other materials provided with the distribution. 

Neither the name of the copyright holder nor the names of its contributors may be used to endorse or 
promote products derived from this software  

without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND 
ANY EXPRESS OR IMPLIED  

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A  

PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR 
CONTRIBUTORS BE LIABLE FOR ANY  

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO,  

PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR 
BUSINESS INTERRUPTION)  

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT 
LIABILITY, OR TORT (INCLUDING  

NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY  

OF SUCH DAMAGE. 
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6. About the Software Bill of Materials (SBOM) 

For this release, a Software Bill of Materials (SBOM) is provided to describe the software components and 
OSS license information included in this product. 

The SBOM is created in SPDX Lite format and is included in the zip archive distributed together with this 
release note. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 

product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 

of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 

or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 

document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 

or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 

manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 

each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 

system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 

disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 

that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 

not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 

THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 

products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 

injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 

safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 

aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
 

(Rev.5.0-1  October 2020) 
 

Corporate Headquarters  Contact information 
TOYOSU FORESIA, 3-2-24 Toyosu, 

Koto-ku, Tokyo 135-0061, Japan 

www.renesas.com 

 For further information on a product, technology, the most up-to-date 

version of a document, or your nearest sales office, please visit: 

www.renesas.com/contact/. 

Trademarks   

Renesas and the Renesas logo are trademarks of Renesas Electronics 

Corporation. All trademarks and registered trademarks are the property 

of their respective owners. 
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